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Offer of Sale

Please contact your Parker representation for a detailed ”Offer of Sale”.

FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DESCRIBED 

HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND PROPERTY 

DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and 

authorized distributors provide product or system options for further investigation by users having 

technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection 

of the system and components and assuring that all performance, endurance, maintenance, 

safety and warning requirements of the application are met. The user must analyze all aspects 

of the application, follow applicable industry standards, and follow the information concerning 

the product in the current product catalog and in any other materials provided from Parker or its 

subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or 

system options based upon data or specifications provided by the user, the user is responsible for 

determining that such data and specifications are suitable and sufficient for all applications and 

reasonably foreseeable uses of the components or systems.

WARNING — USER RESPONSIBILITY
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Ordering Code RE06M*T

1. Introduction

Proportional 

pressure 

relief valve

Normaly 

open

Seal Design 

series
(not required 

on ordering)

Onboard 

electronics

NG06 Electronic 

attachment

Command 

signal

Code Pressure stage

05 50 bar

10 105 bar

17 175 bar

21 210 bar

25 250 bar

35 350 bar

Code Command signal

F

Voltage input 0...+10 V 

with reference output 

+10 V

G
Current input 

0...20 mA

R
Current input 

4...20 mA

RE 06 M T 2 1 0

Interface 

ISO 6264

Pressure 

stage

Code Interface

M

Subplate 

mounting

ISO 6264

R 1)

1) external drain with pipe only

Ordering Code RE*T

Proportional 

pressure 

relief valve

Normaly 

open

Seal

Design 

series
(not required 

on ordering)

Onboard 

electronics

Nominal 

size

Electronic 

attachment

Command 

signal

Code Pressure stage

10 105 bar

17 175 bar

25 250 bar

35 350 bar

Code Command signal

F

Voltage input 0...+10 V 

with reference output 

+10 V

R
Current input 

4...20 mA

RE T 1 0

Inter-

face

Pressure 

stage

Code Seal

N NBR

V FPM

Code Nominal size

10 NG10

25 NG25

32 NG32

Pilot oil Options

Poppet 

spring

S

Code Options

omit
Without mech. max. 

adjustment

M
Mechanical max. 

adjustment

Pilot oil

Code Pilot Drain

1 internal external

4 internal internal

Option:

Body only 

P/T-connec-

tion, sole-

noid 180° 

twisted

XG087

Code Seal

N NBR

V FPM
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Code Nominal size

16 NG16

25 NG25

32 NG32

40 1) NG40

50 1) NG50

63 1) NG63

Code Spool type

omit Standard

S07 2) with poppet seals

1) With poppet seal.
2) Not for NG16

Proportional 

pressure 

relief valve

Normaly 

open

Seal

Design series
(not required on 

ordering)

Onboard 

electronics

Nominal 

size

Electronic 

attachment

Command 

signal

RE E T 1 1 0

Slip-in 

mounting

Pressure 

stage

Pilot oil Options

Poppet 

spring

S

Spool 

type

Code Pressure stage

10 105 bar

17 175 bar

25 250 bar

35 350 bar

Code Seal

N NBR

V FPM

Code Command signal

F

Voltage input 0...+10 V 

with reference output 

+10 V

R
Current input 

4...20 mA

Code Options

ohne
Without mech. max. 

adjustment

M
Mechanical max. 

adjustment

Ordering Code RE*E*T
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Code Interface

4

Subplate 

mounting

ISO 6264

x

y

BA

Stift

x

y

A B

Stift

NG 10 und 25 NG 32

6
Stift

x TP

NG 10; 25; 32

Ordering Code R*V

Pressure 

valve

Proportional 

pilot

Seal

Design Design 

series
(not required 

on ordering)

Relief 

function

Nominal 

size

Modifi-

cations

Command 

signal

Code Pressure stage 1)

1 105 bar

3 210 bar

5 350 bar

Code Command signal

10V
0...+10 V (reference 

output +10 V)

4MA 4...20 mA

R V P

Interface

Pressure 

stage

Code Seal

1 NBR

5 FPM

Code Nominal size

03 NG10

06 NG25

10 NG32

Drain port Options

Max. pressure 

350bar

5

Code Options

PN
Without mech. max. 

adjustment

PM 4) Mechanical max. 

adjustment

Pilot oil

Code Drain

0 internal

1 2) external from 

subplate

2 3) external from valve 

body (Y-port)

Pilot oil

Code Design series

A R4V

B R6V

Pilot oil drain

Code Valve Drain

3 R4V Y-port at subplate

9 R6V Y-port = G 1/8"

1)   Other pressure stages on request
2) Only R4V
3) Only R6V
4) R4V: Adjustment with acorn nut
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Proportional 

pressure relief 

valve
Proportional 

control

Seal

Design 

series

Nominal 

size

Options

Command 

signal

Code Pressure stage

1 105 bar

3 210 bar

5 4) 350 bar

Code Command signal

10V
0...+10 V (reference 

output +10 V)

4MA 4...20 mA

R5V P A

Pressure 

stage

Code Seal

1 NBR

5 FPM

Body Options

SAE 

interface

Code Options

PN
w/o mechanical max. 

adjustment

PM
with mechanical max. 

adjustment

2

Pilot oil

Code Nominal size

06 SAE ¾"

08 SAE 1"

10 SAE 1¼"

12 1) SAE 1½"

SAE 61

Code Size
Max. pressure 

[bar]
3 12 210
4 10 280
5 06/08 350

SAE 62

Code Size
Max. pressure 

[bar]
6 2) 06/08/10/12 350

2-port body

Code Pilot ports

7 Y1 = G1/4 " 3)

3-port body

Code Pilot ports

3 M = 7/16 - 20 UNF

9 M = G¼

Ordering Code R5V

Code Option

152
3-port body with 

metric threads

1) Only R5V 3port
2) Only R5V 3port
3) Y1 only available at external drain (pilot oil code 6).
4) R5V10-4*5 up to 280 bar.
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Parker R*V / RE*T pressure valves have an integral 

electronic and requires only one sole electrical 

common for the control system. Different flow sizes, 

as well as command signal options are available 

to achieve an optimal adaption for different appli-

cations.

Block diagram of integral elektronics

Code F/10V

Code G/R/4MA

Characteristics of Valve Driver 

The described integral electronic driver combines 

all necessary functions for the optimal operation of 

the valve. The most important features are: 

•฀ digital circuit design

•฀ high dynamic constant current solenoid con-

trol 

•฀ differential input stage with various command 

signal options

•฀ two quadrant ramp function

•฀ MIN adjustment for deadband compensation

•฀ MAX adjustment to match the command signal 

span to the valve operating range

•฀ optional reference outputs 10 V for potentio-

meter supply

•฀ standard central connection

•฀ compatible to the relevant European EMC-

standards

•฀ comfortable interface program

PE

E

C

D

A B

Command

Potentiometer
supply

Supply
voltage

G

µC

0 V

F, 10V: 0...10 V

+10 V

18...30 V=

+

Reference

PE

18...30 V=

E

D

A B

Command

Supply
voltage

G

µC

0 V+

Reference

R, G, 4MA:
4...20 mA

A TP

RE06M*T
Parametrizing connector

Central connector
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Name plate example

hydr. circuit symbol

order code

RE06M10T2V1F0M

Technical data

General

Design Pressure valve

Operation Proportional solenoid

Mounting pattern see ordering code

Installation position any

Hysteresis [%] ± 1.5 of pmax

Ambient temperature range [°C] -20...+60

MTTFD value 1) [years] RE06M*T: 150

RE*E*T, RE*M*T, RE*R*T, R4V, R5V, R6V: 50

Protection class IP65 acc. to EN 60529

Vibration strength [g] 10 sinus 5...2000 Hz acc. to IEC 68-2-6

30 noise 20...2000 Hz acc. to IEC 68-2-36

15 shock acc. to IEC 68-2-27

Hydraulic

Fluid Hydraulic oil according to DIN 51524

Viscosity,  permitted

 recommended

[cSt] /

[cSt] /

[mm²/s]

[mm²/s]

20...400 

30...80

Fluid temperature [°C] -20...+70 (NBR: -25...+70)

Filtration ISO 4406 (1999); 18/16/13

Operation pressure max. [bar] 350 ports P, A (X);  30 ports T, B (Y)

R5V: 350 ports A, B (for SAE61 size 10: 280, 

size 12: 210); 30 port Y1

Electrical

Duty ratio ED % 100

Supply voltage Ub VDC 18...30, ripple < 5 % eff., surge free

Current consumption max. A 2.0

Pre-fusing A 2.5 medium lag

Potentiometer supply Up V +10 / ±5 % max. 10 mA

Command signal Ue V Code F/10V: 0...+10, ripple < 0.01 % eff., surge free, Ri = 100 kOhm

Ie mA Code R/4MA: 4...20, ripple < 0.01 % eff., surge free, Ri = < 250 Ohm

< 3.6 mA = enable off, 

> 3.8 mA = enable on (acc. NAMUR NE43)

mA Code G: 0...20, ripple < 0.01 % eff., surge free, Ri = < 250 Ohm

Differential input voltage max. V 30 for terminal D and E against PE (terminal G)

V 11 for terminal D and E against 0V (terminal B)

Adjustment ranges Min % 0...50

Max % 50...100

Ramp s 0...32.5

Interface RS 232C, parametrizing connection 5polig

EMC EN 61000-6-2, EN 61000-6-4

Central connection 6 + PE acc. EN 175201-804

Cable specification mm² 7 x 1.0 overall braid shield

Cable length max. m 50
1) If valves with onboard electronics are used in safety-related parts of control systems, in case the safety function is requested, the valve 

electronics voltage supply is to be switched off by a suitable switching element with sufficient reliability.
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Signal flow diagram
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2. Safety Instructions     

Please read the operation manual before instal-

lation, startup, service, repair or stocking! Paying 

no attention may result in damaging the valve or 

incorporated system parts.    

Symbols

This manual uses symbols which have to be follo-

wed accordingly:

      

 Instructions with regard to the warranty

     

 Instructions with regard to possible 

damaging of the valve or linked system 

components

  

 Helpful additional instructions

     

Marking, Name Plates

Instructions applied on the valve, i.e. wiring dia-

grams and name plates, must be observed and 

maintained legibly.

      

Work at the Valve

Workings in the area of installation, commissioning, 

maintenance and repair of the valve may only be 

allowed by qualified personnel. This means persons 

which have, because of education, experience 

and instruction, sufficient knowledge on relevant 

directives and approved technical rules.

     

3. Important Details

Intended Usage

This operation manual is valid for proportional 

pressure valves RE06M*T / RE*M*T / RE*R*T / 

RE*E*T / R4V / R5V / R6V series. Any different or 

beyond it usage is deemed to be as not intended. 

The manufacturer is not liable for warranty claims 

resulting from this.

Common Instructions

We reserve the right for technical modifications of 

the described product. Illustrations and drawings 

within this manual are simplified representations. 

Due to further development, improvement and 

modification of the product the illustrations might 

not match precisely with the described valve. The 

technical specifications and dimensions are not 

binding. No claim may resulting out of it. Copyrights 

are reserved.

Liability   

The manufacturer does not assume liability for 

damage due to the following failures:

•฀ incorrect mounting / installation 

•฀ improper handling   

•฀ lack of maintenance   

•฀ operation outside the specifications

  

 Do not disassemble the valve! In case of 

suspicion for a defect please return the valve 

to the factory.

Storage   

In case of temporary storage the valve must be 

protected against contamination, atmospheric ex-

posure and mechanical damages. Each valve has 

been factory tested with hydraulic oil, resulting in 

protection of the core parts against corrosion. Yet 

this protection is only ensured under the following 

conditions:    

 Outdoor storage or within sea and tropical 

climate will lead to corrosion and might disable 

the valve!    

Storage 

period
Storage requirements

12 months
constant humidity < 60 % as well 

as constant temperature <  25 °C 

6 months
varying humidity as well as   

varying temperature <  35 °C
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Mounting     

•฀ Compare valve type (located on the name plate) 

with part list resp. circuit diagram.

•฀ The valve may be mounted fix or movable in 

any direction.

•฀ Verify the mounting surface for the valve. Une-

veness of 0.01 mm/100 mm, surface finish of 

6.3 µm are tolerable values.

 Keep clean valve mounting surface and work 

environment!   

•฀ Remove protection plate from the valve moun-

ting surface 

•฀ Check the proper position of the valve ports 

and the O-rings.

•฀ Mounting bolts:     

use property class ISO 4762-12.9

•฀ Tighten the bolts crisscross with the following 

torque values acc. to table below

4. Mounting / Installation

Scope of Supply

Please check immediately after receiving the valve, 

if the content is matching with the specified scope 

of supply. The delivery includes:

•฀ valve

•฀ operation manual

The central connector assembly as well as the 

parametrizing cable has to be ordered separately 

and are not included in the delivery.

 Please check the delivery immediately after 

receiving the shipment for apparent damages 

due to shipping. Report shipment losses at 

once to the carrier, the insurance company 

and the supplier!

Valve type Bolt dimensions Torque value Ordering number

RE06M*T 4 pcs. M5x30 mm 7.6 Nm BK375

RE10M*T/R4V03 4 pcs. M10x35 mm 63 Nm BK505

RE25M*T/R4V06 4 pcs. M10x45 mm 63 Nm BK485

RE32M*T/R4V10 6 pcs. M10x45 mm 63 Nm BK506

RE10R*T/R6V03 4 pcs. M12x45 mm 108 Nm BK494

RE25R*T/R6V06 4 pcs. M16x70 mm 264 Nm BK366

RE32R*T/R6V10 4 pcs. M18x75 mm 398 Nm BK507

RE16E*T 4 pcs. M8x40 mm 31.8 Nm BK414

RE25E*T 4 pcs. M12x50 mm 108 Nm BK391

RE32E*T 4 pcs. M16x55 mm 264 Nm BK415

RE40E*T 4 pcs. M20x70 mm 517 Nm BK416

RE50E*T 4 pcs. M20x75 mm 517 Nm BK417

RE63E*T 4 pcs. M30x100 mm 1775 Nm BK418

R5V * * *

 Insufficient condition of the valve mounting 

surface migth create malfunction! 

 Incorrect mounting resp. bolt torque may 

result in abrupt leakage of hydraulic fluid on 

the valve ports.

Available bolt kits

Operation Limits    

The valve may be operated within the determined 

limits only. Please refer to the “technical data“ 

section as well as to the “characteristic curves“ in 

the catalog.

 Follow the environmental conditions! Unallo-

wable temperatures, shock load, aggresive 

chemicals exposure, radiation exposure, 

illegal electromagnetic emissions may result 

in operating trouble and may lead to failure! 

Follow the operating limits listed in the “spe-

cifications“ table!

* The dimension of the screws resp. tie rods 

depends on the used SAE flanges and on the 

number of SAE valves.
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HFA oil-in-water emulsion

HFB water-in-oil emulsion

HFC aqueous solution (glycols)

HFD unhydrous fluids (Phosphor-Ester)

Pressure Fluids

The following rules applies for the operation with 

various pressure fluids:

This information serves for orientation and 

does not substitute user tests among the 

particular operating conditions. Particularly 

no liabiliy for media compatibility may be 

derived out of it.

Mineral oil: usable without restriction.

For operation with the following pressure fluids 

please consult Parker:

For detailed information concerning pressure 

fluids note VDMA-document 24317 as well as 

DIN 51524 & 51502.

Special gaskets may be available depending on 

the utilized fluid.

In case of insecurity please consult Parker.
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Electrical Connection

The electrical connection of the valve takes place 

by one common cable, which is coupled to the 

integrated electronic driver by a central connector 

assembly.

     

The connection requires a 6 + PE female connector 

EN 175201-804.

 The female connector has to be ordered 

separately under article nr. 5004072.  

  

 A female connector with metal housing is 

required! Plastic made models may create 

function problems due to insufficient EMC-

characteristics.    

     

The connecting cable has to comply to the following 

specification:

Cable type control cable, flexible, 

  7 conductors, overall braid   

  shield   

Cross section min. AWG16/1.0 mm2

Outer dimension 8...12 mm

Cable length max. 50 m

 For cable lengths > 50 m consult factory.  

 

The connection cable is coupled to the female 

connector by solder joints.

Skinning lengths for the connecting cable:

The shielding has to be assembled according the 

outline below:

The backshell nut of the cable gland has to be 

tighten with a suitable tool. The target value for the 

tightening torque is 4 Nm. Tighten the cap nut with 

a torque of approx. 5 Nm after attaching the female 

connector on the socket outlet.  

 Incomplete tightening of backshell nut resp. 

cap nut may result in automatic release of 

the connection as well as degradation of the 

water tightness.

 Follow the “instructions for use“ for installation 

of female connectors made by other kind of 

brands!    

 The cable connection to the female connector 

has to take place by qualified personnel! A 

short between individual conductors resp. to 

the connector housing , bad soldering as well 

as improper shield connection may result in 

malfunction and breakdown of the valve.  

     

 The mounting surface of the valve has to be 

tied to the earth grounded machine frame. The 

earth ground wire from the valve connecting 

cable as well as the cable shield have to be 

tied to the protective earth terminal within the 

control unit. It is necessary to use a low ohmic 

potential connection between control unit and 

machine frame to prevent earth loops (cross 

section AWG 6).

 Do not disconnect cable socket under tensi-

on!

7/8-20
UNEF-2B

Ø
2

8
.6

max. 67

PG13.5
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Command signal input:

The solenoid current behaves proportional to the 

command signal amplitude.

Details are shown from the technical specifications.

 

 The command input signal needs to be fil-

tered as well as free of inductive surges and 

modulations. Due to the sensitivity of the 

valve a high signal quality is recommended, 

this will prevent malfunction.

 Incorrect signal amplitude levels may disturb 

the functionality and can damage the valve.

 The option 4...20 mA uses the “0 mA“ con-

dition as breakdown-information. This means 

the presence of an evaluable failure infor-

mation if the input signal line is interrupted. 

In this case the actuator drive will be swit-

ched off. The drive will switch on when the 

input signal reaches a value of 3.8 mA, it 

switches off when the command falls below 

3.6 mA. This determination follows the NA-

MUR-specification NE43.

 NAMUR is an association of users of process 

control technology.

Electrical Interfacing

  

Supply Voltage:  

The supply voltage for the valve has to cover the 

range of 18...30 V. The residual ripple may not 

exceed 5 % eff.

  

 The applied power supply must comply to the 

relevant regulations (DIN EN 61558) and must 

carry a CE-mark. The operating voltage for the 

valve must be free of inductive surges. Do not 

exceed the max. value of 30 V! Non-observance 

of this rule may result in permanent damaging 

of the valve.

  The increased inrush current of the valve 

should be considered when selecting the 

power supply. A stabilized power supply with 

overcurrent limiting feature should not be 

used. Due to the inrush current of the valve the 

current limit circuit may respond prematurely 

and create problems during energizing of the 

supply voltage.

 The operation of the valve is blocked if the 

supply voltage polarity is interchanged.

 Each valve requires a separate pre-fuse (ra-

ting: s. techn. data). Non-observance of this 

instruction may create irreparable damage of 

valve resp. incorporated system parts.

control system

0 V

valve

Wiring diagram of supply voltage
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Wiring diagram of voltage command input 0...+10 V code F/10V

Wiring diagram of voltage command input 0...+10 V via potentiometer code F/10V

 The external potentiometer is fed via the output “potentiometer supply”. To prevent this output from 

overload, the resistance value of the potentiometer should be within a range of  5...10 kOhm. A 

nominal power rating of 0.1 W is sufficient.

B

C
D

E

F

A

Ue

0 V
input
signal

control system

valve

Reference
command

B

C
D

E

B

C

A

valve

potentiometer
command signal

control system

Ue

0 V

+Up

0 V+10 V

5...10 k

Wiring diagram of current command input 0...20 mA code G

le

le

input
signal

control system

valve

Reference
command

Wiring diagram of current command input 4...20 mA code R/4MA

le

le

input
signal

control system

valve
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5. Operating Instructions

Basically the valve performs the task of converting a 

command signal into a proportional spool stroke with 

the highest possible dynamic. For these purposes 

the input value will be electronically processed and 

provides via a power amplifier stage the required 

current for the valve solenoid.

ProPxD parameterizing software

The ProPxD software permits comfortable parame-

ter setting for the module electronic. Via the clearly 

arranged entry mask the parameters can be noticed 

and modified. Storage of complete parameter sets 

is possible as well as printout or record as a text 

file for further documentation. 

The PC software can be downloaded free of charge 

at www.parker.com/euro_hcd – see page “Support" 

or directly at www.parker.com/propxd.

Hardware requirements 

•฀ PC with operating system from Windows® XP 

upwards 

•฀ Interface RS232C  

•฀ display resolution min. 800 x 600 

•฀ connection cable between PC and electronic 

module 

•฀ storage requirement approx. 40 MB 

 If your PC has no serial interface according 

to RS232C standard you require in addition 

an USB-RS232C adapter.

Parametrizing cable 

Ordering code: 40982923

 The cover plug has to be re-installed after 

completion of the parametrizing work.

Cable Specification

 Attention! The valve electronic provides no 

USB interface, but can only be parametrized 

via an RS232C - connection. Therefore the 

usage of USB standard cables is not allowed 

and may result in damaging of valve resp. PC.

Program installation

Please check before installation if the above hard-

ware requirements are met. If your PC has already 

stored an older version of the “ProPxD” program, 

it has to be deinstalled by using the Windows® - 

system control feature.

Program installation sequence:

•฀ terminate the execution of other programs

•฀ execute the file “setup.exe”

•฀ follow the instructions on the screen 

Answer the question, if an older version should be 

overwritten, with “ok”. During the installation you 

may change destination drive resp. installation 

path, if needed.

Please answer also “ok” if at the end of the installation 

the program reports any system information. After 

successful installation the desktop display shows 

the ProPxD icon for starting the program.
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Software Operating

Brief instruction for first startup:

•฀ Connect the valve electronic to the supply voltage.

•฀ Connect the valve electronic to a PC via the 

parametrizing cable.

•฀ Start the operating program.

•฀ After displaying the program resp. data base 

version a program window opens and the 

connected valve will be automatically identified 

(possibly a manual identification via the button 

“Receive all” is necessary).

•฀ Select the desired version via the menu “Op-

tions/Optionen” with the menu item “Language/

Sprache”.

•฀ The valve specific default parameters are already 

available within the parameter table.

•฀ Parameter changes are possible via mouse or 

the arrow buttons on the bottom left within the 

program screen, also the parameter values may 

be edited via the keyboard.

•฀ Modified parameters will be stored via the “Enter” 

key or via the button “Update list”.

•฀ Parameters have to be nonvolatile stored on the 

valve via the button “save parameter”.

•฀ The chosen parameters may be optionally stored 

on the PC via the “File”-menu with the menu item 

“Save as”, data retrieving is always possible via 

the function “Load file”

Extended functions:

The user software is shared into 2 parameter 

ranges: 

•฀ basic mode 

•฀ expert mode 

For normal startup the basic mode is sufficient. It 

permits the setting of all application specific para-

meters to match the valve function with the task 

setting. 

In case of special applications the valve parameters 

may be adapted via the expert mode. The operating 

mode may be selected from the “Options”- menu 

and remains after terminating and re-start of the 

program. 

 Changing of expert parameters is only per-

mitted for qualified personnel. Incorrect 

settings may lead to malfunction! In case of 

parameter changes shut the drive down!

To prevent an unauthorized access for the expert 

mode, a pass word is requested. The name is 

“parker” and cannot be changed. Thus additionally 

to the button “Default” for loading of the default 

parameters, the button “Send parameter” appears 

in the “Expert”-operating mode. This button trans-

mits only the setting of one single parameter to 

the connected valve. Thus a quick tuning of single 

parameters is permitted during the setup.  

 A horizontal bar graph readout between the 

communication buttons shows the data 

transfer state.

 Because the ProPxD program has also wit-

hout connection to the valve functionality, a 

manual pre-selection of the parameters is 

possible. After selection of the valve type via 

the menu “Options” the parameters may be 

set and stored for later transmission.

 Note the design series while selection of the 

valve!

The “File” menu provides the functions “Printer 

setup”, “Print preview” and “Print”. The print preview 

includes the option for parameter set storage as 

text file (format.txt) prior to further processing. The 

“Options” menu provides also the selection of the 

RS232C interface port via the menu item “Port”. 

Via the menu item “Load file” previously stored 

parameter sets may be loaded.

Adjustment parameters 

The available parameters may be divided into 

multiple groups and are characterized by different 

letters: 

S-parameters

P-parameters

J-parameters
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Parameter overview for basic mode

Parameter Description Unit
Parameter range Default 

setting
Comment

from up to

S5 ramp accel. channel A ms 0 32500 0

S6 ramp decel. channel A ms 0 32500 0

P3 MAX channel A % 50.0 100.0 100.0

P7 MIN channel A % 0.0 50.0 0.0

P11 polarity command – 0 1 0

E19
cable break detection 

command
– 0 1 0

Codes R/S/4MA 

only

E25 MIN operating threshold –
0 = 1%

0 = 1%
1 = 0.01%

Individual description of basic parameters

S5

ramp accel. channel A

Adjustment of ramp rate for increasing of the positive signal polarity.

To avoid switching noise.

S6

ramp decel. channel A

Adjustment of ramp rate for decreasing of the positive signal polarity.

To avoid switching noise.

P3

MAX +

Adjustment of maximum signal span for positive output signal.

To match the command signal span to the valve operating range.

P7

MIN +

Adjustment for positive output signal step at 0,1% command signal.

To compensate for the operate threshold of the valve function.

P11

command signal polarity

Adjustment of the command signal polarity.

To match the command signal polarity to the valve function.

E19

cable break detection 

command

Adjustment of the operating mode for the command cable break 

detection. To turn on resp. off of the cable break detection of the 

command signal at a selected command signal option of 4...20 mA.

E25

MIN operating threshold

Adjustment of the MIN operating threshold.

To match the response sensitivity for the MIN-stroke step.

P5

dither amplitude

Adjustment of dither amplitude.

To reduce the influence of solenoid friction.

P6

dither frequency

Adjustment of dither frequency.

To match the dither signal to the valve dynamic.

Individual description of expert parameters

Parameter overview for expert mode

Para-

meter
Description Unit

Parameter Range
Default Setting Comment

from up to

P5 dither amplitude % 0 10.0
depending on 

valve type

P6 dither frequency Hz 0 300
depending on 

valve type
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Failure message Description/corrective action

The Com Port is not available! Terminate the other program, or quit the message and select ano-

ther RS232C port via the menu “Options > Port”. Afterwards recon-

nect the parametrizing cable.

Unable to open COM port Com port is not available. Quit the message and select another 

RS232C port via the menu “Options > Port”. Afterwards reconnect 

the parametrizing cable.

There is no module/valve 

connected or the communica-

tion is disturbed! Please check 

also the interface!

No data exchange possible. Either the electronic has been remo-

ved, the port is mismatched, or the connection will be disturbed by 

strong electrical fields. Check if the Com port is set for “9600, 8, 1. 

none, none” via the menu “Options > Port”.

Wrong password Retype the password, notice the exact spelling (case sensitivity).

Wrong input An unvalid character or a value outside the permitted range has 

been used at parameter entry.

Keep the entered para-me-

ters?

During parameter loading from the electronics memory the preset 

parameters from the left hand screen display may be rejected or 

maintained.

The chosen module/valve 

isn´t the same as the connec-

ted hardware. Attention! Unsa-

ved parameters will be lost.

In principle, parameters dedicated to a type which deviates from 

the connected valve may be edited. However, for data transmitting 

the correct valve has to be connected. If parameters will be loaded 

from a valve which deviates from the selected one, the parameters 

from the left hand side screen display of the program will be ove-

rwritten.

The chosen hardware isn´t 

the same as the connected 

module/valve.

The wrong valve type has been selected from the database, afte-

rwards the function “send all” has been executed.

Attention! Factory settings 

will be changed! Transmit 

anyhow?

Default parameters has been read out from the database instead 

from the valve via the function “receive all”.

file name.pxd already exists. 

Do you want to replace the 

file?

The file name already exists within the indicated directory. Select 

another name, another directory or overwrite the existing file with 

“OK”.

Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure mes-

sages.

Failure messages and corrective actions:
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malfunction at hydraulic load runtime

- generally no function

- high frequent oscillation

- low frequent oscillation

- pressure at unchanging command

- pressure too low

- drifting without command

possible reasons for malfunction corrective actions

x hydraulic pump resp. motor defective replace hydraulic pump resp. motor

x x x x drive overloaded reduce pressure resp. speed, increase valve size

x x x x x valve contaminated clean pressure fluid, filter / flush valve

x x hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature

x x too low oil level within tank refill pressure fluid

x x filter contaminated replace filter

x x x x supply voltage too low keep supply voltage range

x supply voltage carries too much ripple reduce ripple

x x command signal too low increase command signal

x command signal carries too much ripple reduce ripple

x dither signal amplitude too high reduce parameter P5

x dither signal amplitude too low increase parameter P5

x x x x x central connector contact failure clean contacts resp. replace connector

x feed cable interrupted fix feed cable

x x x x x x wiring sequence incorrect correct wiring sequence

x x feed cable without shielding change cable grade

Air Bleeding of Hydraulic System 

During initial startup, after an oil change as well as 

after the opening of lines or valves the hydraulic 

system must be air bleeded.

Filter

The function and lifetime of the valve are strongly 

affected by the cleanliness of the fluid.

purity level class of 18/16/13 acc. ISO4406 is re-

quired.      

Flushing    

It is recommended to flush the pipelines by short 

circuiting the pressure and return lines. This prevents 

the installation dirt from entering the valve.

6.  Trouble Shooting     

Basis of troubleshooting is always a systematic 

approach.

For suspect of a sluggish spool the valve may 

be flushed with clean pressure fluid.

Troubleshooting in a hydraulic system requires 

detailed knowledge about function and 

construction of the system. Therefore the work 

may exclusively be performed by qualified 

personnel.



22

Proportional Pressure Valves

Series RE*T / R*VOperation Manual

Parker Hannifin Corporation

Hydraulics Group

RE_-R_V obe_24-45-A-B 5715-651 UK 20.11.15

Spare parts / seal kits

7. Accessories / Spare Parts

Accessories

The following accessories are available for the 

valves series:

female connector 6+PE ordering code 5004072

Bolt kits: see table on page 11.

Hotline in Europe

Tel.: 00800-2727-5374

Please direct technical product enquiries to:

Parker Hannifin 

Manufacturing Germany GmbH & Co. KG

Hydraulic Controls Division Europe

Gutenbergstr. 38

41564 Kaarst, Germany

Tel.: (+49) 181 99 44 43 0

E-mail: valveshcd@parker.com

1) Please combine seal kit of one size with seal kit of pro-

portional section P2 for complete seal kit.

 NBR: S26-58473-0, FPM: S26-58473-5.

Valve type NBR FPM

RE06M*T SK-RE06MTN SK-RE06MTV

R4V03 S26-58507-0 1) S26-58507-5 1)

R4V06 S26-58475-0 1) S26-58475-5 1)

R4V10 S26-58508-0 1) S26-58508-5 1)

R6V03 S26-98589-0 S26-98589-5

R6V06 S26-96396-0 S26-96396-5

R6V10 S26-96392-0 S26-96392-5

RE16E*T SK-RE16EN SK-RE16EV

RE25E*T SK-RE25EN SK-RE25EV

RE32E*T SK-RE32EN SK-RE32EV

RE40E*T SK-RE40EN SK-RE40EV

RE50E*T SK-RE50EN SK-RE50EV

RE63E*T SK-RE63EN SK-RE63EV

R5V06 S16-91850-0 S16-91850-5

R5V08 S16-91851-0 S16-91851-5

R5V10 S16-91852-0 S16-91852-5

R5V12 S26-27421-0 S16-27421-5


